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Installing the NADFAS Style Guide – Windows 7 

This guide explains how to install the NADFAS templates and dictionary for use with 
Word 2013. It does not explain how to use the templates. 

Before you begin, put the two templates on your desktop. 

A Creating the NADFAS Style Guide folder 
You need to create a folder on your local disk (C:) to hold the templates and dictionary. It 
is important to create the folder in the correct location with the correct name. If you do 
not do this, the templates will not work. 

1 From the Windows desktop, on the Taskbar, click Windows Explorer (or press 
Windows + E). 

 
2 On the toolbar above the left pane, click Organize.  

 
3 Click Folder & Search Options. 
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4 On the View tab, in the Advanced settings box, scroll down until you can see Hide 
extensions for known file types. This box should not be selected. If there is a tick 
in the box, click the box to clear it, and then click OK.  

 
5 In the left pane, scroll down until you can see drive C: – you may need to click the 

little arrow next to Computer to make it visible. 

 
6 Click drive C: so it is highlighted. 
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7 On the toolbar above the left pane, click New Folder.  

 
8 You'll see a New folder appear in the right pane with the text highlighted. 

 
9 Without clicking anywhere, type NADFASStyleGuide and press ENTER to name 

the folder. 

 
10 Double-click the NADFASStyleGuide folder to open it. You'll see its name at the 

end of the address bar at the top of the window. Computer > C: > 
NADFASStyleGuide. 

 

Move the templates into the folder 
1 Click Minimize 0 on Windows Explorer so you can see the desktop. 

2 On the desktop, select the templates. You can select both at once by clicking one and 
then holding down the CTRL key and clicking the other. If you prefer, you can 
move them one at a time. 

 
3 Press CTRL +X to cut the selected templates. 



A Creating the NADFAS Style Guide folder 

 4 

4 Click Windows Explorer on the Taskbar to return to the NADFASStyleGuide 
folder. 

 
5 Click in the currently empty right pane and press CTRL +V to paste the templates. 

 
6 You should have two files in the folder: 

• NADFAS2Intro.dot 

• NADFAS2Section.dot 

Move the dictionary 
Carry out these steps ONLY if you already have a NADFAS.dic which contains words 
you want to be able to use with Word 2013. If you do not have a NADFAS.dic that you 
want to use, you will create it later and can ignore this section. 

1 Using Windows Explorer, navigate to the folder containing your NADFAS.dic. 

2 Select it and press CTRL +X. 

3 In the left pane, click drive C:, then, in the right pane, double-click 
NADFASStyleGuide. 

4 Press CTRL +V to paste the dictionary. 

5 You should have three files in the folder: 

• NADFAS2Intro.dot 

• NADFAS2Section.dot 

• NADFAS.dic 
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B Configuring Word 2013 to use the templates 
You need to change some settings in Word to make the templates work correctly. 
Changing these settings will not have an adverse affect on any other work you do in Word. 
Your screen might look different – it depends on what Windows and Office theme you 
are using, but the options will be the same. 

Set a trusted location 
1 Run Word. 

2 On the File tab, click Options. 

 
3 In the left pane, click Trust Center. 
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4 In the right pane, click Trust Center Settings to open the Trust Center. 

 
5 In the left pane, click Trusted Locations. 

 
6 At the bottom of the right pane, click Add new location. 
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7 In the Path: box, type C:\NADFASStyleGuide\ and click OK to add the template 
location. 

 
8 You'll see the folder appear in the User Locations list at the top of the right pane. 

Check macro and add-in settings 
1 In the left pane, click Macro Settings. 

 
2 In the right pane, make sure that Disable all macros with notification is selected. 

This is the default setting, so you should not to have to change it. But if it is different, 
change it. 

3 In the left pane, click Add-ins.  

 
4 Make sure that none of the boxes are selected. If they are, click them to clear the tick. 

5 Click OK to close the Trust Center and return to Word Options 
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Check your dictionary language 
1 In the left pane, click Proofing. 

 
2 In the right pane, click Custom Dictionaries. 

3 In the Custom Dictionaries dialog box, if CUSTOM.dic appears under All 
Languages, just click OK to close the dialog box.  
 
If it appears under a particular language, for example, English UK, you need to 
change it to apply to All Languages unless you have decided to use different 
dictionaries for different languages.  

4 To change the dictionary language, click CUSTOM.dic so that it is highlighted (be 
careful to click the name so you do not remove the tick). 
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5 In the Dictionary language drop-down list, select All languages. 

 
6 Click OK 

Load the NADFAS2Section.dot add-in 
1 In the left pane, click Add-Ins. 

 
2 At the bottom of the right pane, click the Manage list arrow and select Templates. 

3 Click Go. 
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4 In the Templates and Add-ins dialog box, click Add. 

 
5 Navigate to C:\NADFASStyleGuide – the easiest way to do this is to click the 

folder symbol at the left end of the address bar (just before the first item), so that the 
icons change to text. 

  
6 Overtype the text to read C:\NADFASStyleGuide and press ENTER. 

7 Click NADFAS2Section.dot to select it and click OK. 
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8 You'll see NADFAS2Section.dot in the Global templates and Add-ins box with a 
tick beside it showing that it is loaded. 

 
9 Click OK to close the Templates and Add-ins dialog box. 

Set the NADFAS dictionary 
If you do not have an existing NADFAS.dic , Word creates one. Otherwise Word uses the 
one you put in the NADFASStyleGuide folder earlier. You need to carry out this step to 
load the dictionary into Word. 

1 Click the Add-ins tab at the far right of the ribbon. 

 
2 Click Special. 

3 From the list of items, point to Dictionary and then click Set NADFAS Dictionary. 

 
4 Word creates the dictionary in the correct location (or loads the existing dictionary) 

and sets it as the default dictionary for All Languages. 
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5 If you do not want to work with the NADFAS templates now, click Unset NADFAS 
Dictionary to set your own CUSTOM.dic as the default dictionary. This does not 
remove the NADFAS dictionary, it just stops new words from bring saved into it or 
offered as spelling corrections when you are doing other work. 

Add Add-ins to your Quick Access toolbar 
1 On the Quick Access toolbar, click the Customize Quick Access toolbar arrow. 

2 Click More Commands. 

 
3 In the right -pane, above the list on the left, in the Choose commands from list, 

select All Commands. 

 
4 In the list on the left, scroll down and click Add-Ins… (the first one). Click Add 

between the two lists to add the command to your Quick Access toolbar. 

 
5 Click OK. You'll see the Add-Ins command  at the end of the Quick Access 

toolbar.  
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C Using the NADFAS templates 
Each time you want to use the NADFAS templates, you need to load 
NADFAS2Section.dot as an Add-in and set NADFAS.dic as the default dictionary for All 
Languages. 

1 On the Quick Access toolbar, click Add-Ins . 

2 Click the box next to NADFAS2Section.dot to load it. 

 
3 Click OK. 

4 On the Add-Ins tab at the right side of the ribbon, click Special. 

5 From the list of items, point to Dictionary and then click Set NADFAS Dictionary. 

 
TIP: Don't forget to Unset NADFAS Dictionary to restore your own dictionary when 
you have finished working with the NADFAS templates. 
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Installing the NADFAS Style Guide – Windows 8 

This guide explains how to install the NADFAS templates and dictionary for use with 
Word 2013. It does not explain how to use the templates. 

Before you begin, put the two templates on your desktop. 

A Creating the NADFAS Style Guide folder 
You need to create a folder on your local disk (C:) to hold the templates and dictionary. It 
is important to create the folder in the correct location with the correct name. If you do 
not do this, the templates will not work. 

1 From the Windows desktop, on the Taskbar, click File Explorer (or press 
Windows + E). 

 
2 On the ribbon, click View. If you cannot see the ribbon, click the small V next to the 

question mark in the top right corner.  

3 At the right side of the View tab, the File Extensions box should be ticked. If it is 
not, click the box to tick it. 

 
4 In the left pane, scroll down until you can see drive C:. You might have to click the 

arrow next to This PC in order to do so. 

 
5 Click drive C: so it is highlighted. 
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6 On the Home tab, click New Folder. You'll see a New folder appear in the right 
pane with the text highlighted. 

 
7 Without clicking anywhere, type NADFASStyleGuide and press ENTER to name 

the folder. 

 
8 Double-click the NADFASStyleGuide folder to open it. You'll see its name at the 

end of the address bar at the top of the window. This PC > C: > 
NADFASStyleGuide. 
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Move the templates into the folder 
1 In File Explorer, in the left pane, click Desktop. 

 
2 In the right pane, select the templates. You can select both at once by clicking one 

and then holding down the CTRL key and clicking the other. If you prefer, you can 
move them one at a time. 

3 Press CTRL +X to cut the selected templates. 

4 At the far left, just above the left pane, click the Back arrow  to return to the 
NADFASStyleGuide folder. 

5 Click in the currently empty right pane and press CTRL +V to paste the templates. 

 
6 You should have two files in the folder: 

• NADFAS2Intro.dot 

• NADFAS2Section.dot 
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Move the dictionary 
Carry out these steps ONLY if you already have a NADFAS.dic which contains words 
you want to be able to use with Word 2013. If you do not have a NADFAS.dic that you 
want to use, you will create it later and can ignore this section. 

1 Using File Explorer, navigate to the folder containing your NADFAS.dic. 

2 Select it and press CTRL +X. 

3 In the left pane, click drive C:, then, in the right pane, double-click 
NADFASStyleGuide. 

4 Press CTRL +V to paste the dictionary. 

5 You should have three files in the folder: 

• NADFAS2Intro.dot 

• NADFAS2Section.dot 

• NADFAS.dic 

B Configuring Word 2013 to use the templates 
You need to change some settings in Word to make the templates work correctly. 
Changing these settings will not have an adverse affect on any other work you do in Word. 
Your screen might look different – it depends on what Windows and Office theme you 
are using, but the options will be the same. 

Set a trusted location 
1 Run Word. 

2 On the File tab, click Options. 

 
3 In the left pane, click Trust Center. 
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4 In the right pane, click Trust Center Settings to open the Trust Center. 

 
5 In the left pane, click Trusted Locations. 
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6 At the bottom of the right pane, click Add new location. 

7 In the Path: box, type C:\NADFASStyleGuide\ and click OK to add the template 
location. 

 
8 You'll see the folder appear in the User Locations list at the top of the right pane. 
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Check macro and add-in settings 
1 In the left pane, click Macro Settings. 

 
2 In the right pane, make sure that Disable all macros with notification is selected. 

This is the default setting, so you should not to have to change it. But if it is different, 
change it. 

3 In the left pane, click Add-ins.  

 
4 Make sure that none of the boxes are selected. If they are, click them to clear the tick. 

5 Click OK to close the Trust Center and return to Word Options 
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Check your dictionary language 
1 In the left pane, click Proofing. 

2 In the right pane, click Custom Dictionaries. 

 
3 In the Custom Dictionaries dialog box, if CUSTOM.dic appears under All 

Languages, just click OK to close the dialog box.  
 
If it appears under a particular language, for example, English UK, you need to 
change it to apply to All Languages unless you have decided to use different 
dictionaries for different languages.  

4 To change the dictionary language, click CUSTOM.dic so that it is highlighted (be 
careful to click the name so you do not remove the tick). 
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5 In the Dictionary language drop-down list, select All languages. 

 
6 Click OK 

Load the NADFAS2Section.dot add-in 
1 In the left pane, click Add-Ins. 

 
2 At the bottom of the right pane, click the Manage list arrow and select Templates. 

3 Click Go. 
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4 In the Templates and Add-ins dialog box, click Add. 

 
5 Navigate to C:\NADFASStyleGuide – the easiest way to do this is to click the 

folder symbol at the left end of the address bar (just before the first item), so that the 
icons change to text. 

  
6 Overtype the text to read C:\NADFASStyleGuide and press ENTER. 

7 Click NADFAS2Section.dot to select it and click OK. 

 
8 You'll see NADFAS2Section.dot in the Global templates and Add-ins box with a 

tick beside it showing that it is loaded. 
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9 Click OK to close the Templates and Add-ins dialog box. 

Set the NADFAS dictionary 
If you do not have an existing NADFAS.dic , Word creates one. Otherwise Word uses the 
one you put in the NADFASStyleGuide folder earlier. You need to carry out this step to 
load the dictionary into Word. 

1 Click the Add-ins tab at the far right of the ribbon. 

 
2 Click Special. 

3 From the list of items, point to Dictionary and then click Set NADFAS Dictionary. 

 
4 Word creates the dictionary in the correct location (or loads the existing dictionary) 

and sets it as the default dictionary for All Languages. 

5 If you do not want to work with the NADFAS templates now, click Unset NADFAS 
Dictionary to set your own CUSTOM.dic as the default dictionary. This does not 
remove the NADFAS dictionary, it just stops new words from bring saved into it or 
offered as spelling corrections when you are doing other work. 
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Add Add-ins to your Quick Access toolbar 
1 On the Quick Access toolbar, click the Customize Quick Access toolbar arrow. 

2 Click More Commands. 

 
3 In the right -pane, above the list on the left, in the Choose commands from list, 

select All Commands. 

 
4 In the list on the left, scroll down and click Add-Ins… (the first one). Click Add 

between the two lists to add the command to your Quick Access toolbar. 

 
5 Click OK. You'll see the Add-Ins command  at the end of the Quick Access 

toolbar.  
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C Using the NADFAS templates 
Each time you want to use the NADFAS templates, you need to load 
NADFAS2Section.dot as an Add-in and set NADFAS.dic as the default dictionary for All 
Languages. 

1 On the Quick Access toolbar, click Add-Ins . 

2 Click the box next to NADFAS2Section.dot to load it. 

 
3 Click OK. 

4 On the Add-Ins tab at the right side of the ribbon, click Special. 

5 From the list of items, point to Dictionary and then click Set NADFAS Dictionary. 

 
TIP: Don't forget to Unset NADFAS Dictionary to restore your own dictionary when 
you have finished working with the NADFAS templates. 


